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Disclaimers and Limitation on Warranties 
This report was prepared as an account of work sponsored by an agency of the 
United States Government.  Neither the United States Government nor any 
agency thereof, nor any of their employees, makes any warranty, express or 
implied, or assumes any legal liability or responsibility for the accuracy, 
completeness, or usefulness of any information, apparatus, product, or process 
disclosed, or represents that its use would not infringe privately owned rights.  
Reference therein to any specific commercial product, process, or service by trade 
name, trademark, manufacturer, or otherwise does not necessarily constitute or 
imply its endorsement, recommendation, or favoring by the United States 
Government or any agency thereof.  The views and opinions of authors expressed 
therein do not necessarily state or reflect those of the United States Government 
or any agency thereof. 

 
Nexant does not warrant that the program provided is free from coding errors or 
other defects.  User’s use of the program is at the user’s sole risk.  The program 
software and associated documentation may contain defects, fail to comply with 
application specification, and may produce unintended or erroneous results when 
operated by itself or in combination with other hardware or software products.  
The program is provided “as is”.  The user accepts the program provided by 
Nexant “as is” and assumes all risks associated with its use, quality, and 
performance.  To the extent permitted by law, Nexant expressly disclaims any and 
all warranties, whether express or implied, including the implied warranties of 
merchantability and fitness for a particular purpose and all warranties as to the 
accuracy, completeness and non-infringement of the program, used either alone or 
with third party software.  
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Section 1  Introduction 

This user’s manual provides an overview of the installation, start-up, and operation of the Power 
Systems Financial Model (PSFM) developed by Nexant, Inc. for the U.S. Department of 
Energy’s National Energy Technology Laboratory.  The PSFM calculates investment decision 
criteria used by industrial end-users and project developers to evaluate the economic feasibility 
of fossil energy power generation systems and other fossil energy conversion systems.  By 
conducting analysis with the financial model, the DOE will be able to evaluate different power 
systems applications on a uniform basis.   

Questions about the model should be sent to PSFMhelp@netl.doe.gov. 
 

Important: Before proceeding, please refer to Appendix B: System Requirements. 

The Power Systems Financial Model Version 6.6 (references are also made in this manual to 
previous versions of the model, the IGCC Financial Model Versions 3.0 and 4.0) consists of 23 
spreadsheets created in Microsoft Excel 2007 workbook format, with interfaces and supporting 
code developed in Visual Basic.  (An Excel 2003 version of the model is also available.)  The 
spreadsheets in the model are organized into four main sections: data input sheets, supporting 
analysis sheets, financial statements, and project summary result sheets.  Figure 1-1, shown 
below, outlines the main sections of the model and illustrates the process by which the model 
uses input data to perform the calculations required to develop financial statements and summary 
results for power projects.  Table 1-1 describes the spreadsheets in the model. 
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• Escalation
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• Expenses
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• Working capital
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• Income statement
• Cash flow
• Balance sheet
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• Cost summary
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Figure 1-1  Organization of the Power Systems Financial Model 

Table 1-1  PSFM Worksheets 

Worksheet Description 
Overview User selects the active scenario on this sheet, overview of results are displayed 

Results Key financial results are reported 

Plant Performance A summary of plant capacity, outputs, and performance.  No inputs on this page. 

Cost Summary Summary of capital costs, construction costs by year, and operating expenses 

Plant Inputs The input sheet for plant data.  Up to seven plant cases can be entered. 

Scenario Inputs The input sheet for financial, economic, fuels, products, tariff, and construction 
parameters.  The inputs are for all plant scenarios defined in the Plant Inputs sheet.   

COE Calculation Calculates the Cost of Electricity, the Levelized Cost of Electricity and the Capital 
Charge Factor for a given scenario 

Capital Cost Escalation Allows the user to escalate capital costs over the capital expenditure period 

Carbon Calculates the cash flows associated with the cost of carbon allowances or carbon 
taxes 

O&M Input sheet for Variable and Fixed O&M costs for each project.  O&M costs can be 
alternatively entered as a percentage of EPC cost in the Plant Inputs sheet. 

Fuel Forecasts Allows the user to enter annual fuel price forecasts rather than using a uniform 
escalation rate 
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Balance Sheet A balance sheet of liabilities, assets, and shareholder’s equity 

Sources and Uses Accounting of fund sources (debt, equity, revenue) and uses (various expenses) 

Cash Flow Calculates Operating Cash Flow, Net Cash Flow, and Net Cash Available for 
Equity Distribution, upon which the IRR calculation is based.  IRR is thus a 
measure of available Return on Equity. 

Revenues Accounting of all project revenues 

Expenses Accounting of all project expenses 

Financing Accounting of debt financing and repayment 

Interest During Construction  Calculates the interest expenses incurred during the capital expenditure period 

Depreciation Accounts for the depreciation of construction and financing charges.  Either the 
Straight-Line (“SL”) or the Declining Balance (“DB”) methods are selected in the 
Scenario Inputs sheet 

Working Capital Accounts for the initial working capital and changes in working capital 

Construction / Capital 
Expenditure Schedule 

Accounts for the allocation of funds during construction.  The allocation of Total 
Required Capital is specified by percentage per construction year in the Scenario 
Input sheet. 

Escalation Set of escalation factors for each input and product by year, inputted as nominal 
values. 

1.1 DISCOUNTED CASH FLOW AND INTERNAL RATE OF RETURN ON EQUITY 
The PSFM conducts a Discounted Cash Flow (DCF) analysis.  The model was conceived and 
designed primarily to evaluate Independent Power Projects (IPPs), rather than regulated utility 
projects.  The primary financial metric in DCF analysis is the Internal Rate of Return on Equity 
(IRROE).  DCF differs from the regulated utility Revenue Requirements (RR) methodology (as 
specified in the EPRI TAGTM

However, given a specified IRROE, Version 6.6 of the model will iterate to find the 
corresponding COE.    See Section 

), in that the Return on Equity in the DCF is calculated and reported 
as the IRROE, rather than specified as an input, as in the RR.  The RR method calculates the 
Cost of Electricity (COE), whereas in DCF, the revenue received for power generation (“COE”) 
is provided as an input. 

2.9 for instructions for using the COE calculation. 

1.2 THE PSFM MODEL AND THE EPRI TAG
The EPRI TAG

TM 
TM

The RR and DCF methodologies differ in one important respect.  Under RR, given the required 
Internal Rate of Return on Equity (IRROE), Cost of Debt (COD), depreciation, and O&M 
expenses, the methodology computes the necessary COE to support the capital investment and 
operating expenses of the plant.  The COE is then often levelized over a period of 10, 20, or 30 

 Revenue Requirements methodology for computing the cost of electricity has 
historically been the dominant method of financial analysis for power projects.  The 
methodology was developed for, and is most relevant to, regulated investor-owned utility power 
project development.  DCF analysis that calculates an IRROE is most relevant for independent 
power projects that will operate in competitive markets. 
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years.  Under a DCF analysis, given the COE, the COD, and depreciation and O&M expenses, 
the methodology computes the Internal Rate of Return on Equity (IRROE) as the investment 
decision criteria for equity investors. 

The RR method charges each year of the book life (book life =x) with a “book depreciation” 
charge equal to 1/x of the original investment (debt and equity portions) charges corresponding 
to the debt and equity return required on the non-“book”-depreciated portion of the original 
investment, as well as operating expenses over the book life.  (“Tax” depreciation could be done 
over a different period.)  This leads to a series of declining values to pay back the investment, 
with the associated required returns.  These values are used to calculate the yearly Cost of 
Electricity to support the required returns on investment.  The COE is then levelized over a 10, 
20, or 30 year period. 

By contrast in DCF, only the equity investments are represented as negative cash flows during 
the capital expenditure period—any portion of the capital cost that is financed with debt 
(including interest during construction) is treated as a financial obligation that the equity investor 
must service during the operational period via a constant payment comprised of interest and 
principle.  As the loan is paid, the interest portion declines, and the principle portion increases, 
exactly as is the case in the repayment of a home mortgage.  The DCF method computes the 
series of cash flows for the given cost of debt, revenues, and other costs.  The IRR of the net cash 
flows over the life of the project is calculated.  This IRR is thus the Internal Rate of Return on 
Equity. 

[Care should be taken to differentiate IRROE from “return on equity” (ROE).  ROE is computed 
by dividing the cash flow returned to the equity investor in a given year by the equity investor’s 
initial equity investment.  ROE is a year-by-year measure of investment performance while 
IRROE is a measure of an investment’s performance over a period of years.] 

1.3 CONSTANT (REAL) AND CURRENT (NOMINAL) DOLLAR BASIS 
The PSFM allows users to escalate input prices and costs using nominal escalation rates.  
Nominal escalation rates include the effects of both monetary inflation and real price escalation.  
There is no separate parameter for inflation in the model. 

The PSFM is designed to deal with cash flows on a Current, or Nominal basis.  That is to say, 
the dollars in any year represent the actual dollar figure in that year.  The escalation rates for 
prices should thus include both the inflation rate and the escalation rates for individual 
commodity prices.  Nominal dollars are the preferred basis for discounted cash flow analysis 
because this allows for the effects of taxes and depreciation to correctly reflect the interplay 
between depreciation and inflation. 

The IRROE computed by the PSFM includes the general inflation rate embedded in the 
escalation rates.  The computed COE also is based on current dollars. 
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1.4 TIME SENSITIVE MODEL PARAMETERS 
The PSFM contains a number of default input parameters in the Scenario Inputs and Plant Inputs 
sheets.  As is emphasized throughout this manual, the user should independently verify all 
parameters used in the analysis.   

Table 1-2 contains a list of parameters that should be independently verified and periodically 
updated by the user in the PSFM. 

1.5 ORGANIZATION OF THIS MANUAL 
The remainder of this users’ guide to the PSFM contains the following sections: 

 Operation of the financial model 

 Key Definitions and Assumptions  

 Guide to data input in the Plant Inputs and Scenario Inputs sheets  

 An instructions sheet on model installation and start-up procedures  

 A version history of the PSFM 
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Table 1-2  Required Validation of Time Sensitive Default Parameters  

Parameter Input Sheet Description 

Variable and Fixed O&M cost as a 
% of EPC 

Plant Inputs Variable is currently  set to 1.5% of EPC 
cost; Fixed is set to 3.5% of EPC cost 

Variable and Fixed O&M cost 
entered in base year dollars 

O&M If this option is used, the O&M costs 
entered in the O&M sheet should be 
verified to be in the base year of the 
analysis 

Debt/Equity Ratio Scenario Inputs Refer to Section 2.9 for a full set of 
debt/equity assumptions 

Debt Reserve Fund Scenario Inputs If this option is used, the default reserve 
fund interest rate default is 5%, and the 
percentage of total debt service used as 
DRF is 50% 

Working Capital Scenario Inputs If working capital is used, the days 
receivable and payable are set to 30 
days; annual operating cash is set to 
$50,000, and the initial working capital is 
set to 7% of first years revenues.  
Otherwise, these parameters are set to 
zero. 

Allocation of EPC, other capital, 
and financing costs over the capital 

expenditure period 

Scenario Inputs The user should verify that the default 
allocations reasonably correspond to the 
planned project funds outlay during 
construction, or, equally allocate the 
funds over the construction period 

Fuel Price Forecasts Fuel Forecasts If forecast fuel prices, rather than 
constant escalated prices, are used, the 
forecast prices in the Fuel Forecast 
sheet should be verified.  Costs should 
be stated in nominal dollars. 
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Section 2  Operation of the PSFM 

2.1 BASIC OPERATING STEPS 
Upon opening the model, the user will be automatically directed to the project Overview Sheet.  
Once the model is fully opened, the user should follow the three-step procedure illustrated below 
in Figure 2-1 to conduct financial analysis of a power project.  

Step 1
Enter plant data into the Plant Input sheet
 Project summary
 Plant output and operating data
 Capital costs
 Operating costs and expenses

Step 2
Enter scenario specific data into the Scenario Input sheet

 Scenario Options
 Debt Reserve Fund
 Depreciation Technique
 Forecast Fuel Prices
 EPC Escalation

 Project summary
 Plant output and operating

data
 Capital costs
 Operating costs and

expenses

Step 3
Select plant case on the Overview sheet and click on the "Recalulate" button

Model Results
The model will gererate the following key
results:
 Project summary report
 Financial statements
 Supporting analysis sheets

Additional Analysis
Compute the COE, LCOE, and
the associated Capital Charge
Factor fro use in the simplified
COE Equation.

 

Figure 2-1  Operating Steps for the Financial Model 
Step 1   Using the Directory (located on the menu bar), go to the Model Inputs menu option and 
select the Plant Inputs sheet.  The Plant Inputs sheet is the primary repository of project 
summary, plant outputs, capital costs, and operating expense data.  To successfully operate the 
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model, all required plant data should be entered into the relevant project cases.  The Plant Inputs 
sheet is capable of storing data for up to seven plants (Cases A to G).  See Appendix A for a 
detailed documentation and description of the Plant Inputs sheet.    

Step 2   Using the Directory, go to the Model Inputs menu option and select the Scenario Inputs 
sheet.  The Scenario Inputs sheet is the repository for key financial, economic, pricing, and 
construction schedule data.  Some data is specific to each plant (such as capital expenditure start 
date and duration), but most other data is general to all plant configurations (such as escalation 
factors, depreciation technique, and plant life.)  Prior to conducting analysis, all scenario specific 
data should be entered and/or reviewed by the user of the model.  In particular, the user of the 
model should ensure that the data contained in the plant construction section and project debt 
terms is still valid.   

Important   It is important to note that sheets contain both input and calculation cells.  Input cells 
are designated by a blue color code and calculation (formula) cells are designated by a red color 
code.  The user must avoid entering any data in cells that are colored red, although generally 
these cells are protected (see also the Troubleshooting section).  See Appendix A for detailed 
documentation and description of the Scenario Inputs sheet. 

Important The data in the Scenario Inputs sheet applies to all plant configurations entered into 
the Plant Inputs sheet.  This is so that alternative plant configurations can be compared on an 
equivalent basis.  If the user wants to compare the same set of plant configurations based upon 
different scenario data, a copy of the spreadsheet should be made and the Scenario Inputs data 
should be changed. 

Important The user should not rely upon any of the default values in the Scenario Inputs sheet 
(such as yearly EPC and capital cost allocations, fuel prices, escalation factors for capital costs, 
electricity price,  or O&M costs, etc.)  All data should be independently developed and verified.   

Step 3   Using the Directory, return to the Overview sheet.  Using the drop-down box located in 
the upper left-hand corner of the Overview sheet, select a plant case to be evaluated (the names 
of projects entered in the Plant Inputs sheet will be displayed in this drop-down box).  As a final 
step after selecting a case, click-on the “Recalculate” button (also located in the upper left-hand 
corner of the sheet) to ensure that any recently entered data is incorporated into the final analysis.   

Very Important   Each time data is entered or changed in the Scenario Inputs sheet, the user 
must go to the Overview sheet and click “Recalculate” to ensure that the new scenario data is 
loaded and the cash flows recalculated for the new case. 

2.2 PLANT OPERATING DATA, COSTS, AND THE CAPACITY FACTOR 
All plant inputs, outputs, and cost data on the Plant Inputs sheet are entered on the basis of 100% 
plant capacity.  The model automatically adjusts fuel consumption, other inputs, electricity and 
other outputs, and variable costs to correspond to the Overall Capacity Factor entered in Line 28 
of the Plant Inputs sheet. 
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Variable Cost as a percentage of EPC entered on Line 49 of the Plant Input sheet is also on the 
basis of 100% capacity.  If variable and fixed costs are entered as dollar values in the O&M 
sheet, the basis for the variable costs is 100% capacity factor. 

2.3 SCENARIO BASE YEAR 
The base year for all scenarios is entered in the Scenario Input sheet in Cell C126.  This base 
year is the first year of capital expenditure for all projects entered into the PSFM. 

2.4 RUNNING SCENARIOS 
Up to seven different plant profiles can be maintained in the Plant Inputs sheet.  However, only 
one scenario profile can be stored in the Scenario Inputs sheet.  Each time a new case is run, it is 
important that the user review the Scenario Inputs sheet to ensure that the input data is still 
relevant to the new case.  Results for a specific plant case are generated each time the user 
selects a case from the drop-down box (located in the Overview sheet) and clicks on the 
“Recalculate” button.  The model is designed such that that specific plant designs and cases are 
compared on an equivalent basis using the same scenario profile. 

There are several key input selections on the Scenario Inputs worksheet that should be noted.  
The user must specify if each of these options is in effect in the current scenario with a “yes/no” 
or selected choice in the Scenario Input sheet.  See also Appendices A and B for further 
information. 

 Debt Reserve Fund (Line 38): Yes/No to include a debt reserve fund in the scenario.  

 Plant Ramp-up (Line 147): Yes/No to active a plant ramp-up, in which the plant ramps 
up its capacity factor over two years, quarter by quarter.   

 Depreciation Technique (Lines 42-43): Choice of straight-line or 150% declining 
balance (15 or 20 years) depreciation techniques.  The half-year convention is used with 
the declining balance method.  The user enters “SL” (straight-line) or “DB” (150% 
declining balance, 15 or 20 years.)  

Capital Costs and Financing Costs are depreciated separately.  Only those costs that are 
indicated as being depreciable on the Plant Inputs sheet are included in the capital and 
financial cost depreciation. 

 Capital Cost Escalation (Line 131): Yes/No to escalate capital costs over the capital 
expenditure period. 

 Forecast or Escalated Fuel Prices (Line 100): Yes/No option to use forecasted vs. 
escalated prices.  Fuel price can be escalated from a base by a constant escalation factor, 
or forecast prices (from EIA, for example) can be used. 

 Investment Tax Credit (Lines 89-90): The Investment Tax Credit (ITC) is applied to 
the EPC cost, and credited in the first year of start-up.  If no ITC is desired, a 0% rate 
should be entered. A maximum allowable ITC can also be specified.  The ITC cannot be 
carried over into future years. 
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Reminder The user should not rely upon any of the default values in the Scenario Inputs sheet 
(such as yearly and capital cost allocations or fuel, capital cost, or tariff escalation factors.)  All 
data should be independently developed and verified. 

Important Reminder Any time that changes are made to any data input sheet, including the 
Scenario Inputs, the Plant Inputs, or the Fuel Forecast Prices sheets, the user must return to the 
Overview sheet and press the “Recalculate” button to obtain the current scenario results. 

2.5 MODEL DIRECTORY MENU 
The PSFM has a drop-down Directory menu (see Figure 2-2 below) that allows the user to 
navigate the model’s twenty-three worksheets.  The user can also perform the same functions by 
using the tabs located at the bottom of each sheet.  In Excel 2007, the PSFM Directory is found 
on the Add-Ins tab. 

 

 

Figure 2-2  PSFM Model Directory Menu Display  
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2.6 PROTECTED CELLS 
The model has been set up so that the user is unable to edit, add, or delete any formula contained 
in the non-input sheets of the model.  With the exception of the input sheets (Plant Inputs, 
Scenario Inputs, O&M, Capital Cost Escalation, and Fuel Forecasts) and the COE Calculation 
and Carbon sheets, all of the worksheets in the model are set-up as read-only.   

2.7 PRINTING OPTIONS 
The model has built-in print options that allow the user to print either certain subsets or all of the 
model’s worksheets.  To use this option, the user should go to File ⇒ Print Options… and select 
accordingly.  These ‘Print Options’ should be used while in the Overview sheet.  

In the Excel 2007 version of the PSFM, the Print menu is found on the Add-Ins tab.  

A plant scenario description is included at the top of each printed page.  This description is 
entered in Line 55 of the Plant Inputs sheet for each plant profile.  

2.8 TROUBLESHOOTING 
Table 2-1 contains a list of solutions to potential problems that a user may encounter when 
operating the PSFM.   

Table 2-1  Power Systems Financial Model Troubleshooting Recommendations 

Problem Possible Solutions 
Results are missing, do 
not appear in the form of 
a number, or appear to 
be incorrect 

• Click the “Recalculate” button 
• Excel’s auto-calculation feature might be turned off.  Go to Tools ⇒ Options…  

Click on the Calculation tab.  Click on the Automatic box, then select OK 
• Check that data in the Scenario Inputs sheet are in accordance with the Plant 

selection that you have made 
• Check that all inputs are correctly entered.  For those inputs involving specific unit 

types, ensure that the unit amounts and types are correct 
• Check that the formula cells (shown in red) in the Scenario Inputs sheet have not 

been altered.  If the formulas have been altered, open the original version or a 
backup of the model and create a new file.  The user can then manually re-enter 
any relevant input data into the new version of the model.  The user can prevent 
this problem by avoiding cells colored in red in the Scenario Inputs sheet  

• Make sure you are running the version of the model corresponding to your version 
of Excel, either 2003 or 2007. 

Directory Menu and/or 
Print Option menus are 
missing 

• This is most likely due to the user selecting “Cancel” when asked to save the 
model during the closing process.  To regain the menus, close the model (saved or 
unsaved) and then reopen the file 

Upon opening the model, 
a message appears 
saying: “filename.xls is 
already open.  
Reopening will cause any 

• Make sure that a version of the model with the same file name is not already open.  
When creating copies of the model in which to enter new data into the Scenario 
Inputs sheet, make sure copies of the model have different names corresponding 
to the alternative scenario under consideration. 
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changes you made to be 
discarded.  Do you want 
to reopen filename.xls?” 
 

2.9 COST OF ELECTRICITY AND THE CAPITAL CHARGE FACTOR CALCULATION 
Version 6.6 of the Power Systems Financial Model includes the capability to calculate the Cost 
of Electricity (COE), the Levelized Cost of Electricity (LCOE) and a corresponding Capital 
Charge Factor (CCF) that can be used in a separate, simplified equation for computing COE as a 
function of a limited set of key parameters.  This section explains the methodology and outlines 
the steps required to compute the COE, LCOE and CCF.  

COE 

The COE is defined as the revenue received by the generator per net megawatt-hour during the 
power plant’s first year of operation assuming that this first-year-of-operation COE escalates 
thereafter at a nominal annual rate equal to the general inflation rate, i.e., that it remains constant 
in real terms over the operational period of the power plant.  To calculate the COE, the PSFM 
iterates to find a COE in the first year of operation that, when escalated at the assumed nominal 
annual general inflation rate, provides the stipulated internal rate of return on equity over the 
entire economic analysis period.  The economic analysis period encompasses the capital 
expenditure period (defined on Row 129 of the Scenario Inputs sheet) plus the operational period 
(or “Plant Economic Life”, defined in Cell B53 of the Scenario Inputs sheet).  [Since all inputs 
are entered into the PSFM in base-year dollars, the model actually iterates on a base-year COE 
expressed in base-year dollars, which the model then escalates over the capital expenditure 
period using the general inflation rate to compute the first-year-of-operation COE expressed in 
first-year-of-operation dollars.  However, since the COE is escalated at the general inflation rate, 
it remains constant in real terms and the COE in the first year of operation (which is the value 
being sought) is equivalent to the base-year COE when both are expressed in base-year dollars.]   

When project cash flows are discounted at the internal rate of return, the resulting net present 
value (NPV) is zero.  In the PSFM, the project’s cash flow is determined by accounting for all 
costs and financial obligations and revenues for the project.  The financial obligations include 
service on the project debt.  The remaining positive cash flows are available for return to equity 
investors.  Thus, in the PSFM, the IRROE corresponds to the project’s Return on Equity. 

It should be noted that, should the debt repayment term happen to exceed the specified 
operational period (Plant Economic Life), the debt term is not changed to terminate with the end 
of the operational period. 

LEVELIZED COE 
 
The levelized COE is the revenue received by the generator per net megawatt-hour during the 
power plant’s first year of operation assuming that this first-year-of-operation COE escalates 
thereafter at a nominal annual rate of 0%, i.e., that it remains constant in nominal terms over the 
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operational period of the power plant.  The PSFM reports LCOE on a current-dollar basis over a 
levelization period that is equal to the power plant’s assumed operational life (“Plant Economic 
Life”, defined in Cell B53 of the Scenario Inputs sheet).  “Current dollar” refers to the fact that 
levelization is done on a nominal, rather than a real, basis1

 

.  To calculate the LCOE, the PSFM 
first calculates the base-year COE as described above.  Next, it multiplies the base-year COE by 
an end-of-year levelization factor (LF) that is a function of the specified IRROE and the general 
inflation rate that was applied to the COE, yielding the LCOE in “base-year” dollars.  If desired, 
the base-year LCOE in base year dollars may then be adjusted to first-year-of-operation dollars 
by escalating the base-year value applying a 3% nominal annual inflation rate.  

If a series of values is uniform over time except for a constant nominal escalation rate, the 
levelized value of the series can be calculated by multiplying the initial value by the levelization 
factor.  The present value of the series of escalating values is equal to the present value of the 
series of levelized values (when both are discounted using the discount rate used to calculate the 
levelization factor).  The levelization factor is given by the following equation when cash flows 
are assumed to occur at the end of each year (as is the case with the PSFM): 
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LF = levelization factor 
LP = levelization period, years  
D = discount rate - used the Internal Rate of Return on Equity (IRROE)  
N = nominal escalation rate  
 

Note that we compute nominal escalation as follows:  
 

N = R + I 
 

where: 
R = real escalation rate 
I = inflation rate 
 
 

 

                                                 
1 For this current-dollar analysis, the LCOE is uniform in current dollars over the analysis period.   In contrast, a 
constant-dollar analysis would yield an LCOE that is uniform in constant dollars over the analysis period. 
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STEPS FOR CALCULATING COE AND LCOE 
 
In order to compute the COE and LCOE for a given DCF scenario, the following steps should be 
executed: 

• On the Scenario Inputs sheet (Cell B60), set the COE escalation rate equal to the assumed 
nominal annual general inflation rate. 

• On the COE Calculation sheet (Cell B3), enter the required IRROE.    

• On the COE Calculation sheet (Cell B15), enter an initial guess for the base year COE 
(i.e., the COE in the first year of capital expenditure which the model will then escalate to 
the first year of operation).  Note that the COE entered on the COE Calculation sheet is 
automatically copied to the Scenario Inputs sheet for the cost of electricity in Cell B113.     

• On the COE Calculation sheet (Cell B17), click on the “Calculate COE, LCOE and CCF” 
button.  The model will iterate until a COE is found that achieves the required IRROE to 
within 1% when escalated at the prescribed general inflation rate.  If a #DIV/0 or #NUM 
Error is returned, the calculated IRROE is negative or undefined.  A higher initial 
estimate for the COE must be entered. 

On the COE Calculation sheet (Cells B25 and B26) the PSFM reports the COE for the first year 
of operation in both base-year dollars and first-year-of-operation dollars.  The PSFM computes 
the corresponding current-dollar LCOEs by multiplying the COEs by the levelization factor and 
reports then on Cells B27 and B28.  (The levelization factor is computed by the PSFM using the 
equation described in the preceding section and reported in Cell B29 on the COE Calculation 
sheet.) 

CALCULATING A CAPITAL CHARGE FACTOR (CCF) FOR USE IN A SIMPLIFIED 
COE EQUATION 
 
The PSFM also calculates a capital charge factor (CCF) which is reported in Cell B30 of the 
COE Calculation sheet.  The CCF can be used to calculate COE with the simplified equation 
described below instead of with the PSFM, providing that

• The analysis accepts all of the global economic assumptions prescribed for the underlying 
COE calculation.  The CCF is only valid for the set of global economic assumptions that 
were prescribed for the COE calculation from which it was derived.  Accordingly, the 
simplified COE equation is also only valid for the same set of assumptions.   These include 
assumptions relating to taxes and depreciation, contracting and finance terms, capital 
expenditure period, operational period, capital cost escalation, distribution of capital costs, 
working capital, and escalation of operating revenues and costs.   

: 

• All operational costs and revenues are escalated at the same single nominal annual rate 
during the operational period (capital costs may be escalated over the capital expenditure 
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period at a different rate).  This requirement only applies when using the CCF and the 
simplified COE equation.  If the PSFM is used to calculate COE, there are no restrictions 
on how costs and revenues are defined over the operational period.   

• All capital costs are assumed to be depreciable and entered as such on the Plant Inputs sheet.  
Capital costs that are actually non-depreciable costs should still be entered as depreciable 
costs.  This assumption is made because the simplified COE equation does not discriminate 
between depreciable and non-depreciable capital costs.  Accordingly, for the sake of 
consistency, all capital costs are assumed to be depreciable when calculating a CCF for use in 
the simplified COE equation.  This simplifying assumption introduces a minimal amount of 
error (see Figure 2-3).  This requirement only applies when using the CCF and the 
simplified COE equation.  If a more precise solution is desired that reflects the 
differentiation between depreciable and non-depreciable capital costs, the PSFM should be 
used to calculate COE directly and the CCF and simplified COE equation should not be 
employed.  

The CCF is calculated by solving the simplified COE equation for CCF and entering known 
values for all the other variables.  The COE is set equal to the value calculated by the PSFM, and 
other variables are set equal to the corresponding values that were entered into the PSFM model. 

Using the reported CCF, the following simplified equation can be used to calculate the COE 
(apart from the PSFM) as a function of Total Overnight Capital, base-year operating costs and 
capacity factor.  All costs for the simplified COE equation should be expressed in Base-Year 
(“first year of capital expenditure”) dollars.  For example, if the first year of capital expenditure 
was 2007, the Total Overnight Capital cost and operating costs should be entered in year 2007 
dollars.  

gereratedpower  of
hoursmegawatt net  annual

costs
operating variable
yearfirst 

costs
operating fixed

yearfirst 

charge capital
yearfirst  ++

=COE
 

(CF)(MWH)
))(OCTOC)((CCF) FIX VAROCCFCOE ++

=  

 
where: 
 

COE = revenue received by the generator ($/MWh, equivalent to mills/kWh) 
during the power plant’s first year of operation (but expressed in base-
year dollars), assuming that the COE escalates at a nominal annual 
rate equal to the general inflation rate, i.e., that it remains constant in 
real terms over the operational period of the power plant. 
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CCF = capital charge factor  
 
TOC = total overnight capital (see note below), expressed in base-year dollars 
 
OCFIX

 

 = the sum of all first-year-of-operation fixed annual operating costs, 
expressed in base-year dollars  

OCVAR

 

 = the sum of all first-year-of-operation variable annual operating costs at 
100% capacity factor, including fuel and other feedstock costs and 
(offset by) any byproduct revenues, expressed in base-year dollars  

CF = plant capacity factor, assumed to be constant (or levelized) over the 
operational period; expressed as a fraction of the total electricity that 
would be generated if the plant operated at full load without 
interruption 

 
MWH =  annual net megawatt-hours of electricity generated at 100% capacity 

factor 
 

Total Overnight Capital   The TOC may include any “overnight” capital expense incurred during 
the capital expenditure period, except

Both depreciable and non-depreciable costs should be included in the TOC, even though the 
CCF and the simplified equation assumes that all capital is depreciable.  

 for escalation during construction and interest during 
construction.  (When using the simplified COE equation, both escalation during construction and 
interest during construction are “embedded” in the capital charge factor.)  

Figure 2-3 shows that 
this assumption introduces a negligible amount of error into the capital portion of the COE given 
a typical tax rate and depreciation schedule [38% effective income tax rate (34% federal, 6% 
state) and capital depreciation over 20 years, 150% declining balance].  For example, even if 
25% of the TOC was actually non-depreciable, the capital portion of the COE calculated with the 
CCF (assuming 100% of TOC is depreciable) is only 2.5% less than it should be.  Since capital 
costs are only one component of the COE, the error in the total COE is even less.  If this small 
error is not acceptable, the NETL Power Systems Financial Model should be used in lieu of the 
CCF and simplified COE equation.  
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Figure 2-3 Error Introduced in Capital Portion of COE 

Due to Assumption that 100% of TOC is Depreciable 

 
Expenditures that, at a minimum, should be included in the Total Overnight Capital cost term 
are:  bare erected cost (BEC), EPC fees, project contingency, and process contingency2

The Total Overnight Capital cost may also include other costs (sometimes called “owner’s 
costs”) such as:  project development costs, technology fees, pre-production costs and inventory 
capital.  Project development costs could include items such as environmental 
permitting/characterization costs, legal fees, land costs, and infrastructure improvements such as 
transmission interconnections, roads, and rail lines.  Technology fees include prepaid licenses 
and royalties.  Pre-production costs include operator training, equipment checkout and startup 
costs.  Inventory capital includes spare parts, stored feedstock (fuels and other consumables 
stored on-site), and first fills of chemicals and catalysts within process plant vessels.  

.  The 
BEC includes the cost of process equipment, on-site facilities and infrastructure that support the 
plant (e.g., shops, offices, labs, road), and direct and indirect labor.  EPC fees include costs for 
detailed design (including the Front-End Engineering Design study), construction permitting (but 
not environmental permitting), construction management and EPC engineering support during 
startup.  

                                                 
3  The sum of BEC and EPC fees is commonly called the “EPC Cost”.  The sum of the EPC Cost and costs for 
project contingency and process contingency is commonly called the “Total Plant Cost” (TPC). 
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Financing costs, such as closing costs and any other upfront fees associated with securing 
financing may be included in the Total Overnight Capital cost.  Interest during construction and 
the capital cost escalation during the capital expenditure period should not be included (as they 
are embedded in the CCF).  

2.10  CARBON ALLOWANCES AND CARBON TAXES 
The PSFM accounts for the costs and revenues from the purchase and sale of carbon allowances 
in a cap and trade market.  The PSFM also includes an option for a carbon tax.  

In the Scenario Inputs sheet, the user specifies the market design (Trading, Tax, or None) a 
compliance period (1-5 years), and the rate at which free carbon allocations decline from 
compliance period to compliance period (essentially the “carbon cap”).  

The compliance period is the multi-year period under which the plant must cover its CO2

The plant is provided with a quantity of free allowances at the beginning of each period, which 
declines over time.  The plant can buy additional allowances at auction at the beginning of the 
period.  At the end of the compliance period, the plant will purchase, or sell allowances to cover 
the difference (positive or negative) of carbon allowances acquired at the beginning of the period 
minus emissions over the period  

 
emissions with emissions allowances.  

Banking/borrowing takes place within a compliance period, but not between periods.  

In the Scenario Inputs sheet, the user also specifies the rate of change (positive or negative) 
between compliance periods in the purchase of allowances at the beginning of the compliance 
period; the CO2 allowance price per ton, in first-year-of-capital-expenditure dollars, the carbon 
tax ($/ton of CO2

Free carbon allowances are booked on a zero-cost basis.  Purchases of allowances at auction at 
the beginning of the compliance period or purchase in the market at the end of the compliance 
period is treated as an operating expense.  Sale of allowances is treated as revenue (with a cost 
basis of zero for free allowances and the market price for purchased allowances.)  

; first-year-of-capital-expenditure dollars) and the nominal annual escalation 
rate of the allowance price and the tax rate.  The same escalation factor is used for the allowance 
price and tax rate.  

The option of a simple carbon tax on emissions (in $/ton) is treated as an operating cost.  

The Carbon sheet is where the user inputs the annual CO2 emissions for each of the scenarios in 
the model (on a 100% capacity basis), the number free allowances in the first compliance period 
(which declines by the rate specified in the Scenario Inputs sheet), and the number of allowances 
purchased at auction at the beginning of the first compliance period (which changes by the rate 
specified in the Scenario Inputs sheet).  The model calculates the quantity of allowances that 
must be purchased at the end of the period based on the specified emissions and the specified 
free and purchased allowances at the beginning of the period.   



Section 3  Key Definitions and Assumptions 

 Power Systems Financial Model Version 6.6 User’s Guide 19 

The cash flows for the selected scenario and the carbon market parameters are calculated on the 
Carbon sheet.  The user should first clear the existing cash flows in the sheet by pressing the 
appropriate button, and calculate new cash flows for the new scenario.  

Scenario Analysis  

Users can examine the financial impacts of investment in carbon reduction technologies.  

First, by inputting the market design parameters and market costs for CO2

Then, two scenarios could be set up in the model: a CCS case with higher capital costs and a 
higher risk financial structure, but with lower carbon emissions, and a case without CCS, with 
lower capital costs, and a lower risk financing structure.  

, the impact on the 
IRROE and COE can be examined, holding everything else constant.  

A combination of free and auctioned allowances would be acquired by each plant at the 
beginning of each compliance period.  The CCS plant might be able to sell allowances into the 
market, if the market design were to allocate carbon allowances to the CCS plant as if it were a 
conventional PC unit as an economic incentive.  The conventional plant would need to purchase 
credits in excess of its free allowances and bear the associated costs.  

The scenarios could also be compared with a simple carbon tax.  In both cases, the price of 
carbon, either via a tax or the market price of allowances, can be adjusted to determine at what 
point the investment in carbon reduction bears a positive return relative to the conventional case.  

Note: When running both a carbon tax scenario along with any allowance scenario, the 
escalation rate of both scenarios should be equal to one another for the model to give an accurate 
representation of the comparative costs.    

2.11 CAPITAL COST ESCALATION 
To escalate capital costs over the capital expenditure period, the following steps should be 
executed: 

• On the Scenario Inputs sheet, enter the capital cost escalation rate in Cell B83. 

• On the Scenario Inputs sheet, enter “Yes” in Cell B131. 

• On the Capital Cost Escalation sheet, click on the “Copy” button. When the “Copy” button 
is clicked, the Capital Cost Escalation sheet calculates an escalated EPC and a corresponding 
set of cost allocation percentages and copies these values back to the Scenario Inputs sheet.  
Note that the “Copy” button must be clicked to update the escalated values whenever 
changes are made to capital costs (Rows 37-44 on the Plant Inputs sheet), the capital cost 
escalation rate (Cell B83 on the Scenario Inputs sheet), the capital expenditure period (Row 
129 on the Scenario Inputs sheet) or the distribution of capital over the capital expenditure 
period (Row 134 on the Scenario Inputs sheet).   
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2.12 MULTIPLE PRODUCTS IN THE PSFM 
The PSFM can incorporate co-production of other plant outputs in addition to power.  Either co-
products with positive value or waste products that subtract from the overall cash flow can be 
entered into the model.  The model contains input cells for flow-rates and values for the 
following co-products: 

 Steam 

 Hydrogen 

 Sulfur 

 Ash 

 Fuels 

 Chemicals 

 Environmental Credits  

 “Other”  

 User Defined Co-Products 1 and 2 

In order to properly include co-products in a power system, the following steps should be taken: 

The “Primary Output” (Plant Inputs sheet, Row 7) should be defined as “Multiple Outputs”.  The 
user inputs the Primary and Secondary fuel consumption in terms units/day (100% capacity 
basis) (lines 32 and 33 of the Plant Inputs sheet) instead of heat rate.  The flow rates of the co-
products (100% capacity basis), the co-product prices, and the co-product escalation rates are 
entered in the Plant Inputs and Scenario Inputs sheets.  Entering these items will assure that they 
are included in the cash flow calculations.  Note that the model typically does not allow negative 
values for tariffs.  In order to include negative values, the user must go into the “Validation” 
section in the “Data” dropdown menu and allow negative values to be included. 

The PSFM model has been used and validated for a number of co-product cases, including 
steam, Fischer-Tropsch (FT) liquids, ammonia, and urea.  Examples of model inputs with co-
products can be seen in the FT and hydrogen cases in the Appendix of the Nexant/DOE report 
“Gasification Plant Cost and Performance Optimization”, DE-AC26-99FT40342, September 
2003. 
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Section 3  Key Definitions and Assumptions 

The following definitions and assumptions are included to provide the user with a more detailed 
explanation of the model’s inputs and parameters.   

3.1 CAPITAL COSTS AND OPERATING EXPENSES 
Bare Erected Cost (BEC) 

The BEC comprises the cost of process equipment, on-site facilities and infrastructure that 
support the plant (e.g., shops, offices, labs, road), and the direct and indirect labor required for its 
construction and/or installation.  The cost of EPC services and contingencies are not included in 
BEC.  BEC is an overnight cost expressed in base-year dollars.  Although the BEC is not used 
explicitly in the PSFM, it is a component of the EPC cost, which is the most fundamental cost 
estimate used in the PSFM.     

Engineering, Procurement, and Construction (EPC) Cost 
The EPC comprises the BEC plus the cost of services provided by the engineering, procurement 
and construction (EPC) contractor.  EPC services include:  detailed design, contractor permitting 
(i.e., those permits that individual contractors must obtain to perform their scopes of work, as 
opposed to project permitting, which is not included here), and project/construction management 
costs.   EPC is an overnight cost expressed in base-year dollars.  EPC is the most fundamental 
cost estimate in the PSFM and should be entered as a lump sum amount (in thousand dollars), 
consistent with the model Base Year (1st

Total Plant Cost (TPC) 

 year of capital expenditure) in Line 37 of the Plant 
Inputs sheet. 

TPC comprises the EPC plus project and process contingencies, which are defined below.  TPC 
is an overnight cost expressed in base-year dollars.  Although TPC is not explicitly used in the 
PSFM, it is a commonly cited level of capital cost.  

Total Overnight Capital (TOC) 

TOC comprises the TPC plus all other overnight capital costs, including owner’s costs.  In the 
PSFM it is the sum of the unescalated EPC, project and process contingencies, additional 
depreciable capital, additional non-depreciable capital, initial debt reserve fund and initial 
working capital.  TOC is an “overnight” cost, expressed in base-year dollars and as such does not 
include escalation during construction or interest during construction.  TOC is an overnight cost 
expressed in base-year dollars.   

TOC is also a variable used in the simplified COE equation.  See Section 2.9. 
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Total As-Spent Capital (TASC) 

TASC is the sum of all capital expenditures as they are incurred during the capital expenditure 
period including their escalation.  TASC also includes interest during construction.  Accordingly, 
TASC is expressed in mixed, current-year dollars over the capital expenditure period.  TASC is 
reported on Row 25 of the Cost Summary sheet and Row 12 of the COE Calculation sheet.  

Project Contingency 

The project contingency is included in estimates to account for unknown costs that are omitted or 
unforeseen due to a lack of complete project definition and engineering.   Project contingency is 
added because experience has shown that such costs are likely, and expected, to be incurred even 
though they cannot be explicitly determined at the time the estimate is prepared.   In the model, 
project contingency costs are entered as a percentage of EPC cost on the Plant Inputs sheet.  
Although contingency factors vary by project, a fifteen percent contingency factor is set as an 
initial default value based on the results of private power developer interviews.  Project 
Contingency is a tax depreciable cost. 

Process Contingency 

Process contingency is designed to compensate for uncertainty in cost estimates caused by 
performance uncertainties associated with the development status of one or more plant sections.  
Usually, this is not applied to the whole plant, but only to the “technologically immature” 
sections, with the value depending upon the developmental status.  Process contingencies are 
added because experience has shown that such costs are likely, and expected, to be incurred even 
though they cannot be explicitly determined at the time the estimate is prepared.  Process 
Contingency is entered as a percentage of EPC cost on the Plant Inputs sheet.  Process 
Contingency is a tax depreciable cost. 

Additional Capital Costs 

Overnight capital costs that are not included in the EPC capital cost, such as owner’s costs.  
Additional capital costs can be depreciable or non-depreciable and are entered as a percentage of 
EPC cost on Rows 43 and 44 of the Plant Inputs sheet. 

Working Capital 

Initial Working capital is the fund that is set up in the year prior to operations to initially fund the 
Working Capital account.  Initial working capital is entered as a percentage of first year revenues 
on the Scenario Inputs sheet.  A default recommendation is 7% of first year’s sales.  Initial 
Working Capital is a non-depreciable expense. 

Days payable and daysreceivable are entered on the Scenario Inputs sheet.  A default 
recommendation is 30 days for both. 
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Annual Operating Cash is entered on the Scenario Inputs sheet.  The default recommendation is 
$50,000. 

Working Capital is calculated in each year as the sum of accounts receivable, inventories, 
operating cash, less accounts payable.  It reflects the amount of capital that is tied up in 
receivables, money invested in inventories, and payables, plus cash on hand.   

The increase in working capital from year to year is subtracted from the operating cash flow to 
reflect how it is used in funding operations, and to maintain the fund at the desired level.  At the 
end of the project life, the Working Capital fund is returned to equity investors as a positive cash 
flow. 

Initial Debt Reserve Fund 

A fund required by some financial institutions to secure debt payments.  (Refer to the Debt 
Reserve Fund section below.)  This is a non-depreciable cost. 

Financing Fees 

Additional fees associated with the debt portion of financing.  This is a depreciable financing 
cost. 

Capital Cost Escalation  

The model allows capital costs to be escalated over the capital expenditure period.  See Section 
2.11.  

Interest During Construction 

Interest charges accumulated during the construction period.  This is a depreciable financing cost 
that is calculated by the PSFM. 

Variable O&M 

Variable O&M costs are dependent on plant output and should be entered on the basis of a 100% 
capacity factor.  Variable O&M costs include all consumable items (except fuel and user defined 
feedstocks entered in Rows 8-11 of the Plant Inputs sheet), spare parts, and labor that fluctuate 
with the actual plant output, and are scaled by the Overall Capacity Factor entered in Line 28 of 
the Plant Inputs sheet.  Variable costs may either be entered as a percentage of EPC cost on the 
Plant Inputs sheet or can be directly entered as dollar values on the O&M sheet. 

Fuel and User-Defined Feedstocks 

These variable costs are dependent on plant output and should be entered on the basis of a 100% 
capacity factor in Rows 8-11 of the Plant Inputs sheet.   
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Fixed O&M 

Fixed costs include labor and other costs that are independent of the plant output level.  Fixed 
cost items must be paid whether or not the plant produces any output.  Fixed costs may either be 
entered as a percentage of EPC cost on the Plant Inputs sheet or can be directly entered as dollar 
values on the O&M sheet. 

Escalation of Operating Costs and Revenues 

The model escalates product prices (the prices charged to end-users for project outputs such as 
electricity, steam, etc.), fuel and user defined feedstock costs, and operating expenses by annual 
nominal escalation rates entered on the Scenario Inputs sheet.  

Forecasted Fuel Costs 

The user has the option to use forecasted fuel prices rather than escalated prices.  The Fuel 
Forecasts sheet is used to enter forecasted fuel costs (for gas, coal, petroleum coke, and “other”) 
over a 35-year period.  There is a “Yes/No” option in the Scenario Inputs sheet to use forecasted 
or escalated fuel costs.  Fuel costs should be entered on a nominal or current basis, which 
includes the effects of both inflation and price escalation or de-escalation. 

3.2 ECONOMIC AND FINANCIAL 
Plant Economic Life 

Plant Economic Life defines how long the plant is assumed to operate.  The period over which 
the model executes the DCF analysis is the Capital Expenditure Period plus the Plant Economic 
Life.  The Plant Economic Life is entered in Cell B53 on the Scenario Inputs sheet.   

It should be noted that, should the debt repayment term happen to exceed the specified 
operational period (Plant Economic Life), the debt term is not changed to terminate with the end 
of the operational period. 

Tax Options  

The financial model contains the following options for calculating annual income taxes: 

 Standard tax rates can be used to calculate annual income taxes for a project under a 
regular tax schedule (i.e., during periods where there are no tax credits or benefits)   

 Subsidized tax rates can be used to evaluate the impact of potential tax credits on a 
project.  Subsidized tax rates can be employed for the entire life of a project or for a 
defined grace period (i.e., a set number of years that the subsidized rate is in effect).   

 Tax holidays can be used to evaluate projects that receive a tax holiday (i.e., no income 
taxes for a designated grace period).  Tax holidays are typically used to evaluate 
international projects.  
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 Investment Tax Credit can be used to reduce the tax burden of the project in the startup 
year.  The project or corporation must have sufficient taxable income to take the full ITC 
in the startup year.  The ITC cannot be carried forward into future years. 

Property taxes should be included in the Fixed O&M costs. 

Multiple Sources of Debt 

The financial model can assess projects using a maximum of three debt sources.  If multiples 
sources of debt are used, the user must specify one loan as senior and the others as subordinated 
debt.  Subordinated debt has a claim on the assets of a project in the event of bankruptcy only 
after senior debt has been paid.  It should be noted that, should the debt repayment term happen 
to exceed the specified operational period (Plant Economic Life), the debt term is not changed to 
terminate with the end of the operational period. 

Debt Reserve Fund 

The option to use a debt reserve fund is included for projects on which lenders require added 
debt service assurance.  To use the Debt Reserve Fund option, the user should enter “Yes” in the 
designated input cell located in the Scenario Inputs sheet (in the Financial Assumptions section).  
To exclude the Debt Reserve Fund option, the user should enter “No.”   

The debt reserve fund is available to pay debt service requirements in the event that the general 
funds available to the project are inadequate.  Based on interviews conducted with financial 
lending organizations, the debt reserve fund amount is estimated to be equal to fifty percent of 
total first year debt service.  The owner of a project using a debt reserve fund is entitled to 
interest earnings on the fund.  An initial interest rate of five percent on the reserve fund is used as 
a default value.  For analysis conducted using this model, debt reserve funds can only be used for 
senior debt (i.e., Project Loan 1).   

Grace Period    

Lenders often grant projects a grace period on the initial repayment of principal.  Therefore, the 
model contains an option for using a grace period (in years) on the repayment of principal for 
each loan. 

Depreciation  

Construction and financing costs can be depreciated using a straight-line method (variable 
number of years) or a 150% declining balance method (with the half-year convention) over a 
period of 15 or 20 years.  Construction and financing charges are separately depreciated. The 
user has the option of not depreciating any financing charges, and can enter “0” as the 
depreciation term for financing.   
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Only those costs that are indicated as being depreciable on the Plant Inputs sheet are included in 
the depreciation.  Initial Working Capital and the Initial Debt Reserve Fund, if included, are non-
depreciable costs. 

For financing costs, the IDC and the Financing Fee are depreciable expenses. 

Discount Rate 

All discount rates are assumed to be in nominal form. 

Power Purchase Agreements (Initial Tariff Level) 

It is assumed that the power purchase agreement (or initial tariff) will be agreed upon prior to the 
start of capital expenditures.  Therefore, initial tariff levels should be entered in current (i.e., the 
first year of capital expenditure) dollars.   

3.3 CONSTRUCTION AND PLANT PERFORMANCE 
Note: Inputs for the project annual operating parameters (such as plant production, heat rate, 
operating hours, availability) are average values for the life of the project, and are entered on the 
basis of a 100% capacity factor. 

Annual Fuel Consumption: Power vs. Non-Power Applications  

Since advanced power systems can generate a wide range of outputs (e.g., electricity, hydrogen, 
steam, etc.), it is important to designate whether or not the generation of power is the primary 
application of a given plant.  The model requires this distinction to be made because for power 
applications, plant heat rate (stated in Btu/kWh) is used to calculate annual fuel costs.  If power 
generation is NOT the primary application of a plant, then plant heat rate is not relevant.  When 
preparing input data for fuel consumption, the user should follow these steps:  

 If the primary application is electric power generation, the user should enter the “Power” 
option in the Primary Output/Plant Application line in the Plant Inputs Sheet.  The user 
should then enter a plant heat rate (in Btu/kWh) in Plant Inputs sheet for each fuel type. 

 If the primary application is NOT electric power generation, the user should enter the 
“Multiple Outputs” option in the Primary Output/Plant Application line in the Plant 
Inputs sheet.  The user should then enter daily fuel consumption level, assuming a 100% 
capacity factor, stated in either Mcf/day or Tons/day in the Plant Inputs sheet for each 
fuel type. 

Base Year – 1st Year of Capital Expenditure 

This is the first year in which any significant capital expenditures (on the order of 10%) are 
made, and is the year used as the base year for discounting cash flows for all plant cases. 
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Capital Expenditure Period 

The Capital Expenditure Period, entered on the Scenario Inputs sheet, is the number of years 
over which capital costs are expended.  It should comprise the construction period at a minimum 
and may also include a period of time prior to the start of construction during which capital costs 
associated with items such as detailed design, permitting and long-lead equipment orders might 
be incurred.   

The user enters the first year of capital expenditure, assumed to commence on January 1st

A five-year capital expenditure period is appropriate for more complex projects, including many 
coal-based power projects, while a shorter, three-year capital expenditure period may be 
representative for simpler projects such as a natural gas fueled power plant. 

, which 
serves as the Base Year for all scenarios for the discounted cash flow analysis in the PSFM.  This 
should be the first year in which any significant capital expenditures (on the order of 10%) are 
made.  A capital expenditure period of 36, 48, or 60 months is entered for each plant case, and 
the model calculates an operation start date for each plant.  Plant production is assumed to start 
on January 1 of the start-up year.  

Plant Heat Rate (Btu/kWh) 

This input is required on the Plant Inputs sheet for projects having electricity generation as the 
primary output.  Plant heat rate is a measure of the amount of thermal energy needed to generate 
a given amount of electric energy.  Plant heat rate is stated in Btu/kWh and is based on the higher 
heating value (HHV) of the relevant fuel.  The user has the option of specifying a primary and 
secondary fuel type. 

For multiple fuels, the heat rate of each fuel type is pro-rated by the percentage of time operating 
on each fuel.  The units of heat rate are then Btu of primary fuel/total kWh produced and Btu of 
secondary fuel/total kWh produced, so that the sum of the heat rates is a weighted average heat 
rate of the whole plant for an operating year. 

Annual Fuel Consumption: Power vs. Non-Power Applications  

Since integrated gasification combined cycle projects and other advanced power systems 
generate a wide range of outputs (e.g., electricity, hydrogen, steam, etc.), it is important to 
designate whether or not the generation of power is the primary application of a given plant.  The 
model requires this distinction to be made because for power applications, plant heat rate (stated 
in Btu/kWh) is used to calculate annual fuel costs.  If power generation is NOT the primary 
application of a plant, then plant heat rate is not relevant.  When preparing input data for fuel 
consumption, the user should follow these steps: 

 If the primary application is electric power generation, the user should enter the “Power” 
option in the Primary Output/Plant Application line in the Plant Inputs Sheet.  The user 
should then enter a plant heat rate (in Btu/kWh) in Plant Inputs sheet for each fuel type. 
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 If the primary application is NOT electric power generation, the user should enter the 
“Multiple Outputs” option in the Primary Output/Plant Application line in the Plant 
Inputs sheet.  The user should then enter daily fuel consumption level, assuming a 100% 
capacity factor, stated in either Mcf/day or Tons/day in the Plant Inputs sheet for each 
fuel type. 

Overall Capacity Factor (%) 

Overall capacity factor, entered on the Plant Inputs sheet, is the percentage of the output that 
would be achieved if the plant operated at full load without interruption.  The capacity factor 
takes into account both planned and forced outages over the entire year (8,760 hours).  The factor 
is applied to all fuel, feedstock, and co-product flow rates, and to Variable O&M. 

Plant Ramp-up Option 

To account for the plant start-up period, the model includes an option to allow the plant to 
gradually reach full capacity.  Specifically, the model calculates an average annual capacity 
percentage for up to the first two full years of operation.  Average annual capacity percentages 
are based on capacity inputs entered by the user for each quarter of the designated two years 
ramp-up period.  The plant capacity inputs entered by the user should reflect both planned and 
forced outages during the initial two-year start-up period.  These factors are independent of the 
Overall Capacity Factor used for following years of operation. 

To use the plant ramp-up option, the user should enter “Yes” in the designated input space 
located in the Scenario Inputs sheet (in the Construction Assumptions section).  To exclude the 
plant ramp-up option, the user should enter “No.”  
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Appendix A Plant Inputs and Scenario Inputs Sheets 

This section refers the user to specific lines in the Plant Inputs and Scenario Inputs worksheets 
noting important plant profile data and scenario data and scenario options, particularly those 
scenario options new in Versions 4 and 5 of the Power Systems Financial Model.  Line numbers 
from the worksheets note each item.  Also see Section 3 for additional descriptions of 
assumptions behind the data and options in the worksheets. 

PLANT INPUTS SHEET 
Line 7: Primary Output/Plant Application 
The user specifies “Power” or “Multiple Outputs” for the project.  If “Power”, then heat rate by 
fuel type is entered in Lines 30-31; if “Multiple Outputs,” then fuel consumption by fuel type is 
entered on Lines 32-33. 

Line 8-9: Primary and Secondary Fuel Type 
A primary fuel type (“Gas”, “Coal”, “Petroleum Coke”, and “Other/Waste”) is entered from the 
drop-down menu in Line 8.  A secondary fuel can be chosen in Line 9 or “None” if there is a 
single fuel. 

Note: the category “Other/Waste” can be used to represent an additional fuel in a plant profile.  
For example, if the plant is to be run on coke and coal as a primary fuel and gas as a secondary 
fuel, the “Other/Waste” category could be used to represent coke and coal by using a weighted 
average (based on BTU content and percentage of each fuel used) for the heat rate, HHV, fuel 
consumption, and price. 

Line 10-11 User Defined Feedstock  
Up to two additional feedstocks can be defined for each case.  The feedstock can be fuel or non-
fuel inputs, and the units and costs should be appropriately defined by the user, on the basis of 
100% capacity.  Only the names of the feedstock are entered on lines 10 and 11.  

Line 13-28: Plant Outputs 
In the case of a plant with multiple outputs, the output quantities entered in these lines.  Units of 
tons are US Short Tons (2000 lbs.)  Two user-defined co-products can be included. 

Line 28: Overall Capacity Factor  
Overall capacity factor, entered on the Plant Inputs sheet, is the annual output achieved by the 
plant, expressed as a percentage of the output that would be achieved if the plant operated at full 
load without interruption.  The capacity factor takes into account both planned and forced 
outages. 

The factor is applied to all fuel, feedstock, and co-product flow rates, and to Variable O&M. 



    

 Power Systems Financial Model Version 6.6 User’s Guide 30 

Line 30-35: Heat Rate/Fuel Consumption 
Enter either the heat rate for the primary and secondary fuel, or the fuel consumption for the 
primary and secondary fuel, and the two user-defined feedstocks, if included.  If there is a single 
fuel type, leave the secondary fuel quantity blank or zero. 

Line 37-38: EPC Cost 
Enter the overnight EPC Cost on Row 37.  The escalated EPC cost on Row 38 is updated by the 
model if the user chooses to escalate capital costs over the capital expenditure period (Cell B131 
on the Scenario Inputs sheet), and clicks the “Copy” button on the Capital Cost Escalation sheet.  
See Section 2.11 for details.  The Base Year, the 1st

Lines 39-44, and Lines 49-53: Other Development Costs, and Fixed and Variable 
Operating Costs 

 year of capital expenditure for all scenarios, 
shown in the Scenario Inputs tab will be the basis for the DCF calculations; EPC cost entries 
should be in Base Year dollars.  

These costs are entered as a percentage of the EPC cost.  Remember that when escalated EPC 
costs are employed, the costs that are entered as a percentage of EPC are based on the escalated 
EPC.   

The user has the option to directly enter or to calculate O&M costs, rather than specify O&M as 
a percentage of EPC.  Cells A51 and A53 provide this option.  

Line 55: Additional Comments 
Descriptions of the plant profile and scenario entered on this line are included in the top of each 
page printed out for the plant cases.  This feature is used to track various scenarios generated, so 
a sufficiently detailed description of the plant case and the scenario assumptions should be 
entered here.  

SCENARIO INPUTS SHEET 
Line 37-39: Debt Reserve Fund 
Indicate “Yes” or “No” to put the debt reserve fund into effect.  

Line 42-43: Depreciation 
“SL” for straight-line method, and “DB” for 150% declining-balance method (with the half-year 
convention).  The straight-line method can use any depreciation life (that is reasonable and 
corresponds appropriately to the plant life); the declining balance method must use either a 15 or 
a 20-year period.  Capital costs and financing costs are separately depreciated.  The user has the 
option of not depreciating any financing costs by entering “0” in Cell B43.  

Line 54 Discount Rate 
This discount rate is only used on the Results sheet to display the corresponding Net Present 
Value at that discount rate.  It is not used as a parameter in any other calculation.  
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Line 57-82: Escalation Factors 
Input escalation factors for project outputs, fuels, and fixed and variable operating expenses.  
These inputs are in nominal terms.  

Line 83: Capital Cost Escalation 
The capital cost escalation factor is used on the Capital Cost Escalation worksheet to calculate 
the escalated EPC and capital costs and re-calculate the cost allocation percentages.  See also 
Lines 134-135 and 144. 

Line 85-90: Tax Assumptions 
The user inputs the tax rates and assumptions for tax subsidies and tax holidays.  The Investment 
Tax Credit (ITC rate) (default is 0%, but 10% is a reasonable assumption if the ITC were in 
place), and the maximum amount of the ITC that is available in the startup year, based upon 
sufficient taxable income for the project or owner.  ITC cannot be carried forward.  

Line 94-99: Fuel and Feedstock Prices 
Fuel prices are assumed to be for the base year over all scenarios (the first year of capital 
expenditure for all projects), and are escalated from this base price.  

Line 100: Forecast Fuel Price Option 
If “Yes” is entered for the option “Use Forecasted Prices?” data from the sheet Fuel Forecasts is 
used in place of the user escalated fuel prices.  

Lines 111-124: Product Prices 
Unit prices for products and co-products are entered in the base year 1st

Line 126: Base Year of Scenario 

 year of capital 
expenditure dollars.  The Cost of Electricity reported in Cell B113 must be entered in Cell B15 
of the COE Calculation sheet, (even if the COE and CCF are not being calculated).  

The 1st

Line 131: EPC Cost Escalation  

 year of capital expenditure for all scenarios is entered in Cell C126.  The first year of 
capital expenditure should be the first year in which significant capital outlays are made.  

If “Yes” is entered for the option “Capital Cost Escalation in Effect?” then the user must click 
the “Copy” button on the Capital Cost Escalation sheet to automatically compute an escalated 
EPC cost and re-calculate the construction cost allocation percentages.  In this case, the model 
uses the percentages from Line 135 rather than those of Line 134.  See Section 2.11.  
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Lines 134-135, 144: Construction and Finance Cost Allocation over Capital Expenditure 
Period 

These allocations are used to spread the EPC related costs and Finance costs over the capital 
expenditure period.  Allocations for 3, 4, or 5 year capital expenditure periods are entered.  The 
allocations apply to all capital related costs.  If the capital cost escalation feature is used, the 
revised allocation factors from the Capital Cost Escalation sheet are used in line 135. 

Line 147: Plant Ramp-up Option 
If “Yes” is input, the plant ramp-up option is put in effect. 

Lines 150-159: Start-up Operations Assumptions on Plant Capacity 
Average annual capacity percentages over the ramp-up period are based on capacity inputs 
entered by the user for each quarter of the designated two years ramp-up.  The plant capacity 
inputs entered by the user should reflect both planned and forced outages during the initial two-
year start-up period.  Important - these factors are independent of the Overall Capacity Factor 
used for following years of operation. 

Lines 172-180: Carbon Market 

Assumptions for carbon taxes or carbon cap and trade are entered in this section. 
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Appendix B System Requirements 

To operate the financial model, the user must be running Excel 2003 or Excel 2007, with the 
‘Analysis ToolPak’ add-in installed.  To install the Analysis ToolPak, go to Tools ⇒ Add-Ins, 
and select the Analysis ToolPak.  Then select OK. 

Important: The Power Systems Financial Model is not backwardly compatible with previous 
versions of Excel.  Separate Excel 2003 and Excel 2007 versions of the model are available. 

Start-up and shut-down of the financial model 

After the PSFM has been successfully installed computer, the model can be opened and closed as 
a regular Microsoft Excel file.  Some general instructions on opening and closing the financial 
model are provided below.     

Opening the Model 
Open Microsoft Excel 2003 or 2007 
Select File ⇒ Open   
Navigate to where you saved “NETL Power Systems Financial Model Version 6.6.xls” during 
the installation process 
Double-click on the “NETL Power Systems Financial Model Version 6.6.xls” file or select it and 
click on open 

Closing the Model 

1. Select File ⇒ Close 
2. Select either Yes or No when asked whether or not you want to save changes.  Do not select 

Cancel.  Selecting Cancel could cause you to remove the Directory and Print Option menus.  
If you do select Cancel, close the model (saved or unsaved) and then reopen the file. 

3. As the user creates more scenarios, he/she may want to establish a subdirectory of folders to 
better manage and maintain different files.  In this manner, past scenarios can be easily 
referenced and used for further analysis.  
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Appendix C Upgrades in Versions 3-6 of the PSFM 

Model Upgrades in Version 6 

Model Upgrades: 

• Costs of carbon allowances and carbon taxes added to the model. 

• User defined co-products and feedstock added to model. 

• Capital cost input categories restructured, and split into depreciable and non-depreciable 
costs 

• New Capital Charge Factors calculated based on model upgrades 

Corrections: 

• Depreciation done over correct period (had been one extra year.) 

• Process contingency correctly treated 

 

Model Upgrades in Version 5 

The model name was changed to the Power Systems Financial Model (from IGCC Financial 
Model), reflecting its applicability to a range of power systems.  Cost of Electricity (COE) and 
Capital Charge Factor (CCF) calculations were added to the model.   

Model Upgrades in Version 4 

Investment Tax Credit 

The investment tax credit (ITC) rate is applied to the EPC cost in the first year of operation.  This 
tax credit is then subtracted from total taxes in the first year operation. 

Operation and Maintenance (O&M) Costs 

There are three means for specifying O&M costs: 1) by entering a percentage of EPC costs for 
fixed and variable O&M; 2) by directly entering fixed and variable costs, or 3) by using a 
calculation spreadsheet that has the user enter the major components of fixed and variable O&M 
costs, such as number of operators, wages and benefits, insurance, and consumables. 
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Model Upgrades in Version 3 

Measurement Units  

All units in the model have been changed to US/British units.   

Capital Expenditure Period 

The capital expenditure period can be set to 3, 4, or 5 years.  The base year of the analysis is the 
first year of capital expenditure, and is the same for all project scenarios in the model. 

Escalation of Capital Costs 

Capital cost escalation was added in Version 3. 

Multiple Fuels 

Version 3 of the model allows the user to specify a primary and a secondary fuel type.  The user 
must specific a primary fuel, and has the option of choosing a secondary fuel or specifying 
“None” in the Plant Inputs sheet. 

Depreciation 

A 150% declining-balance (with the half year convention) over 15 or 20 years has been added as 
an option for depreciation.  In the Scenario Inputs sheet, a “Method” option for depreciation has 
been added.  The user inputs either “SL” or “DB” and specifies the depreciation period.  Error 
checking is performed on the user input. 

Plant Life of 20 to 30 years 

Plant life has been extended to a maximum of 30 years.  A plant life of between 20 and 30 years 
is permitted.  However, since construction can start any time within the first 10 years, the user 
must ensure that the construction start date plus the construction period plus the plant life does 
not exceed 35 years (the maximum number of periods.) 

Printouts 

Model printouts now contain a descriptive comment that is supplied by the user.  This text is 
entered into the “Additional Comments” field on the Plant Input sheet (Line 48) for each plant 
profile. 

Fuel Cost Forecast Data Option  

An input sheet called Fuel Forecasts was added.   
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